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1. 概要 

本資料では、Windows  での  pure::variants  システムのインストールに関し、Setup Guide 

(pure::variants Setup Guide: Version 5.0.7.685 for pure::variants 5.0  －  pv-setup-guide.pdf)  に

記載の情報について基本的な部分を説明します。 

pure::variants  システムは、クライアント、ライセンスサーバー、モデルサーバー、他のコンポ

ーネントで構成されますが、この資料では pure::variants  クライアントと pure::variants  ライセ

ンスサーバーの新規インストールの場合の手順を示します。セットアップの詳細や更新など他の

手順、モデルサーバーや他のコンポーネントのインストール手順などについては、以下に公開され

る Setup Guide Enterprise Edition や Web Components Manual 等を確認ください。 

https://www.pure-systems.com/support/purevariants-technical-documentation 

pure::variants  ライセンスサーバーは、TCP  接続によって  pure::variants  クライアントの複数

のユーザーにフローティングライセンスを与えます。  pure::variants  ライセンスサーバーには

Web  インターフェースがあり、ライセンスの使用状況の確認や、日割り単位でのオフサイトライ

センスの貸し出し等を行うことができます。 
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2. システム構成と要件 

システム構成 

pure::variants  の全体像は次図のとおりで、使用するエンジニアリングツールと  pure::variants  

モデルに必要なデータ管理モードに応じて  pure::variants  のセットアップは図のオレンジ色のボ

ックスで示されるコンポーネントの一部またはすべてで構成されます。  

コンポーネントはITの観点から、サーバー上で実行されるコンポーネントとデスクトップクラ

イアント上で実行されるコンポーネントにグループ化されます。あるシナリオでは、左上に示され

るデスクトップクライアントのコンポーネントのみが必要になりますが、別のシナリオではクラ

イアント側で実行されるブラウザーと組み合わせるサーバーコンポーネントが必要になります。

ブラウザーやLDAPなどのように青色のボックスで示されるコンポーネントもあり、それらは

pure-systems  社からは提供されませんが、特定のシナリオで  pure::variants  コンポーネントと相

互作用します。 
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システム要件 

pure::variants  には、インストールするソフトウェアに応じて異なるシステム要件があります。

それらすべてのシステム要件を下表に示します。 
  

pure::variants 

ソフトウェア 
OS 前提ソフトウェア メモリ 

Eclipseベースの 

クライアント 

Windows 7, 8, 10 

Windows Server 2003, 2008,  

2012, 2016, 2019 

64ビット版 Linux  

(X11ウインドウシステム要) 

Mac OS 

Oracle Java SE 8 もしくは OpenJDK 8 

Eclipse 3.8.0～4.20 

最小：2GB 

推奨：8GB 

ライセンスサーバー Windows 7, 8, 10 

Windows Server 2003, 2008,  

2012, 2016, 2019 

64ビット版 Linux 

 最小：512MB 

推奨：1GB 

データベースをもつ 

モデルサーバー 

Windows 7, 8, 10 

Windows Server 2003, 2008,  

2012, 2016, 2019 

64ビット版 Linux 

Oracle 9 以降 

MSSQL Server 2008 以降 

PostgreSQL 13 以降 

最小：2GB 

推奨：8GB 

Webコンポーネント Windows 7, 8, 10 

Windows Server 2003, 2008,  

2012, 2016, 2019 

64ビット版 Linux 

Oracle Java SE 8 もしくは OpenJDK 8 

Apache Tomcat 8 以 降  も し く は

WebSphere Liberty Kernel v19.0.0.6 

以降 

最小：2GB 

推奨：32GB 

オラクル社提供の公式  Java Standard Edition  (https://www.java.com/en/download/) とOpenJDK  

(https://jdk.java.net/archive/) で Java の互換性がテストされています。 

pure::variants 

ソフトウェア 
CPUコア数  ディスク領域  DBスペース 

Eclipseベースの 

クライアント 

最小：2 

推奨：4 

最小：10GB空き領域  

ライセンスサーバー 最小、かつ推奨：2 最小：10GB空き領域 

データベースをもつ 

モデルサーバー 

 

最小：4 

推奨：4（10アクティ 

ブユーザー*まで） 

以降、10アクティブユ

ーザーごとに1コア追加 

 

最小：10GB空き領域 

（大部分はログに使用 

プ ロ ジ ェ ク ト デ ー タ は

DB スペースに保持） 

プロジェクトやモデルの規模に依存  

MSSQL：1000要素**やリビジョンごとに 

20MB 

Oracle：1000要素やリビジョンごとに4MB 

PostreSQL：1000要 素 **やリビジョンごとに

15MB 

Webコンポーネント  

* アクティブユーザーとは、pure::variants  のサーバーを同時に使用するユーザーのことです 

** 1000要素には、すべてのフィーチャ、ファミリーモデルの要素、バリアントモデルでの選択が含

まれます。また、リビジョンを作成するとスペースが2倍になります 

 

https://www.java.com/en/download/
https://www.java.com/en/download/
https://jdk.java.net/archive/
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3. pure::variants クライアントのインストール 

pure::variants  クライアントはスタンドアローンアプリケーションとしてpure::variants  イン

ストーラーを使用してインストールするか、既存のEclipseツールチェーンにインストールします。 

pure::variants  インストーラーは Windows  用だけですので、Linux  や MacOS X  にインストー

ルする場合は既存のEclipseにインストールすることになります。 

3.1 pure::variants インストーラーによるインストール 

Windows  用インストーラーは、pure::variants  のサイトhttps://www.pure-systems.com/pvde-

update からダウンロードできます。このダウンロードページはパスワードで保護されており、メ

ールアドレスとライセンスファイルにある登録番号でログインする必要があります。 

インストーラーパッケージ (pure::variants Windows Installer Package) をダウンロード・解凍

し、「Setup Enterprise X.Y.ZZ.exe」（X.Y.ZZはバージョン番号）をダブルクリックしてインスト

ールを開始し、以降に示すウィザード（pv-setup-guide.pdf pp.7-9）の手順に従います。 

＊ 一 般 に イ ン ス ト ー ル ソ フ ト は 、 お 客 様 に メ ー ル で ご 案 内 す る pure-systems 社 サ イ ト  

(https://www.puresystems.com/pvde-update)  から、ユーザー名とパスワードでアクセスして

ダウンロード頂いています。特に初めてのお客様の場合は、下図の  pure::variants Windows 

Installer Package  をお勧めします。Eclipse を含めて、全てのライセンスオプションがイン

ストールできます。  

 

このインストーラーは pure::variants  と新規の Eclipse、そしてドキュメント類をセットアップ

します。インストールには管理者権限が必要です。 

アカウントに対して利用可能な  pure::variants  の拡張すべては、ダウンロードしたインストー

ラーに自動的に含まれますが、そのうちいくつかはインストーラーのデフォルトでは有効になら

ないので、必要なものをインストールプロセス中に選択してください。（この選択を後でアップデ

ユーザー名  

https://www.pure-systems.com/pvde-update
https://www.pure-systems.com/pvde-update
https://www.puresystems.com/pvde-update
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ートするには、pure::variantsを再インストールするか、Eclipseのアップデートサイトから実施で

きます） 

また、pure::variants  を実行するには Java  の実行環境 (JRE) が必要です。ご利用のPCに Java  

がない場合は、先にインストールしてください 1。 Java  は https://www.java.com/ja/  からダウンロ

ードできます。64ビット版のバージョン8で、最新のものを使用することが推奨されています。 

インストーラーを起動し、以下の手順ですすめます。 

 

 

 

 
1 インストーラー実行時に右のメッセージが出た場合、JRE

がインストールされていないか、java.exe がデフォルトの

場所 (C:¥Program Files¥Java¥jre1.8.0_301¥bin¥ など) 

でないことが考えられます。 

java.exe がデフォルトの場所でないときは、コマンドプロ

ンプトから /JAVA オプションで  java.exe のインストー

ル場所を指定して、「Setup Enterprise X.Y.ZZ.exe」を

実行してください。 

Next  > をクリックします。 

ライセンス契約を読んで同意し、

Next  > をクリックします。 

https://www.java.com/ja/
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次のウィザードで  Install  ボタンが表示されますので、クリックしてインストール処理を開始し

ます。(コネクタのインストールがある場合、pure::variants  の統合に関するページが表示される

ことがあります)。 

pure::variants  クライアントをイ

ンストールするフォルダを選択

し、Next > をクリックします。 

pure::variants  クライアントと一

緒にインストールするコネクタを

選択し、Next  > をクリックします。 

Windows  のスタートメニュー項

目の名前を入力します (作成しない

こともできます)。Next > をクリ

ックします。 
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3.2 pure::variants クライアントのアンインストール 

pure::variants  クライアントのアンインストールには、Windows  のスタートメニューで アプリと

機能  から pure::variants Enterprise  を選択し、「アンインストール」でアンインストーラーを実行します。 

別に、 pure::variants  クライアントのインストールフォルダからアンインストーラー 

(uninstall.exe) をダブルクリックして実行する方法があります。 

 

アンインストールには管理者権限が必要です。  

Show further manual installation 

steps オプションをチェックする

と、Finish  時に、統合に関する詳

細や手動でのインストールに関す

るドキュメントが開きます。 
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Next  > をクリックします。 

Uninstall をクリックしてアンイ

ンストールを開始します。 

アンインストール完了後、Finish

で終了します。 
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3.3 既存の Eclipse へのインストール (Linux へのインストール) 

Eclipse  のパッケージマネージャによって、アップデートサイトから直接コンポーネントを

ダウンロードして更新するものです。ターゲットとなる  Eclipse  に次の項目がインストールさ

れていることが必要です。  

• JavaScript Development Tools：org.eclipse.wst.jsdt.feature.feature.group  

• Eclipse Business Intelligence and Reporting Tools (BIRT)：org.eclipse.birt.feature.group 

• Graphical Modeling Framework：org.eclipse.gmf.feature.group 

Eclipse  を起動し、Help > Install New Software...  を選択して  Available Software  ウィザードで 

pure::variants update site  を選択します。pure::variants update site  がリストにない場合、Add  して

直接入力します。サイトは https://www.pure-systems.com/pvde-update/ です。 

 

 

項目を選択して Next >  をクリックし、インストール手順を進めます。詳細は、pure-systems 社

ダウンロードサイトにあるビデオ (p.4 図中の2番目の movie) や Setup Guide  の 3.1.2.  項を参照

ください。 

メールアドレスとライセンスファイルにある登録番号で

ログインします 

https://www.pure-systems.com/pvde-update/
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3.4 pure::variants クライアントライセンスのセットアップ 

pure::variants  を使用するには有効なライセンスファイルが必要です。ライセンスなしで

pure::variants  を起動し、ライセンスを要求された場合は、 Yes をクリックしてウィザードで提供

されたライセンスファイルを指定します。メールでお送りしたクライアントライセンスファイル  

(xxx_license.lic) をインストールフォルダ  ( 上記手順のデフォルトでは  C:¥Program 

Files¥pure-systems¥pv_Enterprise_5.0) にコピーしてください。 

次に  pure::variants  を起動してライセンスファイルの場所を設定します。メニューから  

Window > Preferences でウィザードを開きます。Variant Management  >  pure::variants License を

選択し、Install License をクリックして現れるエクスプローラ画面で、上でコピーしたライセンス

ファイルを指定してください。License Data  の情報が表示されます。 

 

◼ フローティングライセンス使用時の設定 

フローティングライセンスをご使用の場合、ライセンスサーバーの  URL  をクライアントで設定

してライセンスサーバーに接続できるようにします。 

クライアントライセンスファイル (xxx_client_license.lic) では、 

 <subtype>licence server</subtype> 

として URL を設定せずに送付されますので、下図のように subtype タグの url 属性を挿入してク

ライアントライセンスファイルで URL を指定します 2。 

 
2 この操作を実施しない場合、Preferences ウィザードから  Variant Management  > pure::variants License > 

License Server で、ライセンスサーバーの URL を設定します。 (Setup Guide の 4.9.1. Setup License Server 

Location  を参照) 
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この  URL  は、次章ライセンスサーバーのインストールで設定する  Address  と  Port  からなるも

のです。 

  

<?xml version="1.0" encoding="UTF-8"?> 
<licence version="1.1"> 
  <product> 
    <name>pure::variants</name> 
    <version>5</version> 
    <function>de</function> 
    <platform>win32</platform> 
  </product> 
  <creation>1-8-2021</creation> 
  <type>float</type> 
  <subtype url="http://pvlicense.example.com:80">licence server</subtype> 
  <registration> 
    <firma>ACME Inc.</firma> 
    <name>Jane Doe</name> 
    <email>jane.doe@acme.acme</email> 
    <number>1234567890ABCD</number> 
  </registration> 

<signature>12 … EF</signature></licence> 

ポート番号を含む完全ドメイン名で設定します。 
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4. pure::variants ライセンスサーバーのインストール 

4.1 Windows インストーラーによるインストール 

Windows  インストーラーは、 pure::variants  のサイト http://www.pure-systems.com/pvde-

update からダウンロードできます。このダウンロードページはパスワードで保護されており、メ

ールアドレスとライセンスファイルにある登録番号でログインする必要があります。 

ライセンスサーバーのインストーラー「Setup License Server X.Y.ZZ.exe」（X.Y.ZZはバージョ

ン番号）をダウンロードし、ダブルクリックしてインストールを開始します。インストールには

管理者権限が必要です。 

 
 

 

ライセンスサーバーを  Windows  のサービスとして実行することをお勧めします。これにより

システム起動時にライセンスサーバーが自動的に起動されます。 

Next > をクリックします。 

ライセンスサーバーを Windows

のサービスとして実行するかどう

かを選択します。 Next > をクリッ

クします。 

http://www.pure-systems.com/pvde-update
http://www.pure-systems.com/pvde-update
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ライセンス契約を読んで同意し、

Next > をクリックします。 

ライセンスサーバーをインストー

ルするフォルダを選択し、Next > 

をクリックします。 

Windows のスタートメニュー項

目の名前を入力します  (作成を無

効にすることもできます)。Next > 

をクリックします。 
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次に、ネットワークオプションを構成します。  

 

* Addressフィールドを空白のままにすると、ライセンスサーバーは使用可能なすべてのネ

ットワークインターフェースで自動的に有効になります。HTTPSを使用したサーバー通信

の暗号化には、ライセンスサーバーに X.509 証明書が必要です。証明書のセットアップは

インストーラーの別のウィザードで行われます。通信用のポートには、デフォルト値 

(HTTPの場合は80、HTTPSの場合は443)が最適です。このポートがファイアウォールでブ

ロックされたり、別のサービスによって使用されないことを確認してください。 

 

 

* 証明書の形式はPEMである必要があり、他の型はサポートされていません。 

Address には、ライセンスサービス

を有効にするホスト名か IP アドレ

スを指定します。 

「Encrypt ～」をチェックして暗号

化のオプションを選択すると、

HTTP の代わりに HTTPS  を使用

してライセンスサーバーの通信を

暗号化できます。 

Port で通信用のポートを指定しま

す。 

Next > をクリックします。 

暗号化を有効にした場合、上部の

ファイルフィールドに  X.509  証

明書のパスを入力します。証明書

がパスワードで保護されている

場合、Password フィールドにそ

のパスワードを入力します。 

Next > をクリックします。 
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* サーバーライセンスファイルをこのフォルダに今すぐ配置することも、後でライセンスサ

ーバーのWebインターフェースを使用してライセンスをインストールすることもできます。 

 

ライセンスサーバーにはWebインターフェースがあり、Webインターフェースを使用してライ

センスの管理ができます。 

次のウィザードでWebインターフェースを有効/無効にできます。 

 

* パスワードで保護する場合、HTTPSも有効にしてください。暗号化しないとパスワード

盗難のリスクがあります。 

 

Windows  サービスのオプションを選択している場合、インストールが正常に完了した後にライ

センスサーバーが自動的に起動します。 

  

License Pool でライセンスファイ

ルを保存するフォルダを選択しま

す。 

Log File でサーバーログのファイ

ルを指定します。 

Next > をクリックします。 

Password  フィールドにパスワー

ドを設定してWeb インターフェー

スを保護してください。 

Install をクリックすると、インスト

ールプロセスが開始されます。 
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4.2 pure::variants ライセンスサーバーのアンインストール 

pure::variants  ライセンスサーバーのアンインストールには、Windows  のスタートメニューで 

アプリと機能  から pure::variants License Server 5.0  を選択し、「アンインストール」でアンインストーラー

を実行します。 

別に、pure::variants  ライセンスサーバーのインストールフォルダからアンインストーラー 

(uninstall.exe) をダブルクリックして実行する方法があります。 

 

アンインストールには管理者権限が必要です。 

 
 

 
 

Next > をクリックします。 

Uninstall をクリックしてアンイン

ストールを開始します。 
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4.3 アーカイブからのライセンスサーバーのインストール (Linux へのインストール 3) 

pure::variants  のサイトhttp://www.pure-systems.com/pvde-update からライセンスサーバーのア

ーカイブをダウンロードして展開し、作成したディレクトリ (次が推奨です) に置きます。 

 /opt/pure-variants 

ライセンスファイルのディレクトリ 

 /opt/pure-variants/licenses 

を作成し、送付されたサーバー用のライセンスファイルをそこに置きます。 

展開したライセンスサーバーの  server ディレクトリにある  start.sh スクリプトをテキスト

エディタで編集し、次を設定します。 

• HOSTNAME：ライセンスサーバーが動作するサーバーマシンのホスト名かIPアドレス 

• PORT：サーバーマシンで通信するTCPポート番号 

• LICENSEDIR：ライセンスファイルのディレクトリ 

クライアントはここで指定したサーバーマシンのポートに接続できることが必要ですので、こ

のポートがファイアウォールでブロックされたり他のサービスで使用されないようにしてくださ

い。ポート番号は 0 ～ 65535 で、80 がHTTPでの標準、443 がHTTPSでの標準です。標準のポー

トを使用するとファイアウォールの問題が起こりにくくなります。 

start.sh を実行してサーバーを開始します。このスクリプトをシステム起動時に自動実行する

には、ご利用システムのドキュメントを参照ください。 

Web  インターフェースを有効にするには、start.sh スクリプトの最後にあるサーバーのコマ

ンド行で次のオプションを指定します。 

--enableweb 

--webpwd <パスワード> 

 
3 Windows でもアーカイブからインストールできます。Setup Guide の 4.2.2. Install from Archive を参照くだ

さい。 

アンインストール完了後、Finish

で終了します。 

http://www.pure-systems.com/pvde-update
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サーバーの Web  インターフェースは常にパスワードで保護されますので、安全なパスワードを

使用してください。 

 

4.4 ライセンスサーバー Web インターフェース 

ライセンスサーバーには  Web インターフェースがあり、フローティングライセンスの追加やラ

イセンスの更新、状況やログの確認、日割り単位でのオフサイトライセンスの貸し出し等を行うこ

とができます。詳しくは、Setup Guide の 4.5. Basic Setup with the pure::variants License Server 

Web Interface の各項目を参照ください。 

下図はライセンスの状況や使用の詳細を表示する例です。 
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5. モデルサーバーと Web コンポーネントのインストールについて 

◼ モデルサーバーのインストール  

ライセンスサーバーのインストールと同様、Windows  インストーラーを使用する方法とアーカ

イブから展開する方法 (Linux向け) があります。 

Windows  インストーラー「 Setup Database Server X.Y.ZZ.exe」とアーカイブは、

pure::variants  のサイト http://www.pure-systems.com/pvde-update  にあり、次のステップで実施

します。 

• データベースと ODBC  データソースのセットアップ 

• モデルサーバーのインストール 

• モデルサーバーのセットアップ 

詳細は、Setup Guide  の 5.1. Install pure::variants Model Serverを を参照ください。 

 

◼ Web コンポーネントのインストール  

Apache Tomcat  もしくは WebSphere Liberty  上に Web  コンポーネントの WAR  形式ファイル 

(com.ps.consul.server.oslc-x.x.x.war) をコピーします。このアーカイブはpure::variants  の

サイトの pure::variants Windows Installer package  にあります。 

Setup Guide  の  9.1.1. Install pure::variants Web Components  では  Apache Tomcat  と 

WebSphere Liberty  のインストール、構成設定について説明されています。 

 

  

http://www.pure-systems.com/pvde-update
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6. Eclipse 環境の日本語化 

ここでは、Babel Project  による方法を紹介します。pure::variants IDE (Eclipse) メニューのア

ップデートマネージャー (Help > Install New Software...  ) からインストールできます。 

本例の場合、Available Software  の Add Repository  ウィザードで以下の URL を Update Site  とし

て Location  に登録して接続し、日本語化言語パックを選択してインストールしてください。 

https://archive.eclipse.org/technology/babel/update-site/R0.17.1/2018-12/ 

 

 

 

 

Name のリストを探して日本語 (Babel Language Packs in Japanese) にチェックを入れ、Next > 

します。 

* ここで、次図のように第2レベルのリストで、Babel Language Pack for rt.rap Japanese  のチ

ェックを外してください。 

https://archive.eclipse.org/technology/babel/update-site/R0.17.1/2018-12/
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これで日本語化に対応した必要なパッケージが選択されますので  Next >  で次に進みます。 

License Agreements  の画面では、同意して Finish  でインストールを開始します。 

Security Warning  の確認画面では、Install anyway  を選択して先に進みます。残りのパッケージ

がインストールされ再起動を促すダイアログが表示されます。 

 

Restart Nowで Eclipse  が再起動されて各種メニューが日本語化されます（いくつかのメニュー

は日本語化されません）。 

  



 

22 

7. クライアントの実行 

6.1 サンプルプロジェクト 

各種サンプルプロジェクトは、メニューの ファイル  から 新 規  > サンプル  で開くことができます。 

 

 

 

 

 

 

 

 

 

 

 

 

ヘルプファイルは、ヘルプ > ヘルプ目次 から開くことができます。 

また、以下のサイトに各種チュートリアルも置いていますので、ご参考いただけると幸いです。 

http://www.fuji-setsu.co.jp/products/purevariants/tutorials.html 

 

 

 

 

http://www.fuji-setsu.co.jp/products/purevariants/tutorials.html
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6.2 エラーログ 

実行時のエラーログは、Eclipse クライアントのワークスペース内の.metadataフォルダ

に.logとして格納されます。  
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